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Introduction 
The 2021.1.0 release updates MYOB Greentree to produce files for payday filing in the 
new v2021 format. 

Note:  We recommend that you produce your KED and New and Departing 
Employees files and file them with the IRD before installing this upgrade. 

queries created using the Query Designer as 
panels on a desktop. Query panels support integration with 3D panels, and let you edit 
any parameters set up for the query and save parameters as defaults. 

This release also includes enhancements to the security of the MYOB Greentree 
system (including the ability to authenticate against a Microsoft Exchange server using 
the OAuth 2 authentication standard) and fixes issues identified in Greentree Desktop 
and eDocs. 

The sections below provide full information on all of the changes included in this 
release. 
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New Features 
Desktop  Payday Filing Updates 

These changes apply to NZ companies only 

This release updates MYOB Greentree to produce files for payday filing in the new 
v2021 format. This includes the EI Return file and the Employee Details file, which 
replaces the New and Departing Employees file. The New and Departing Employees 
window is now the Employee Details window: 

 
Open this window at HR > Payroll > Other Functions > Create Employee Details File. 

Select the new EI file format on the Inland Revenue Reporting Configuration window: 

 
Open this window at HR > System > Payroll > Inland Revenue Reporting 
Configuration. 



 

MYOB Greentree 2021.1.0  Page 3 of 19 
Copyright 2021 MYOB Technology Pty Ltd. 

 

Updates to KiwiSaver Information 
The Employee Details file now includes information on employees opting in or out of 
KiwiSaver. The KiwiSaver information included in payday filing has been expanded to 
include information on employees who opt out of KiwiSaver after the normal opt out 
period. 

Note:  Because KiwiSaver information is now included in the Employee Details file, 
you no longer need to produce and send the KiwiSaver Employment Details 
(KED) file. You can still produce a KED file from MYOB Greentree and send it 
to the IRD for now, but the KED file will not be accepted from 1 April 2021. 

Employees can opt out of KiwiSaver between the ends of the second and eighth 
weeks of their employment (i.e. between days 14 and 56) see 

 for more information. 

To opt out after the end of this period, a reason for the late opt out must be accepted 
by the IRD Commissioner before the opt out is effected. Updates have been made to 
the HR Employee Maintenance > Tax Config tab to capture this information: 

 
The Eligibility field now has three options: 

• New 
• Existing Auto enrol (previously Existing) 
• Existing Opt in 

A new KiwiSaver Status dropdown lets you assign one of the following statuses to an 
employee: 

• Auto-enrol 
• Casual/Temporary Employee 
• Existing KiwiSaver Member 
• Not Eligible for KiwiSaver 
• Opting in to KiwiSaver 

Note:  On upgrade, any users who have Enrol in KiwiSaver ticked and Eligibility set 
KiwiSaver Status 

The dropdown is left blank for all other employees KiwiSaver status is not 
required for existing employees. We recommend that you check all 

KiwiSaver Status settings after upgrading to this release. 

https://www.ird.govt.nz/kiwisaver/kiwisaver-individuals/opting-out-of-kiwisaver
https://www.ird.govt.nz/kiwisaver/kiwisaver-individuals/opting-out-of-kiwisaver
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MYOB Greentree now prevents you from opting an employee out of KiwiSaver less 
than 14 days after their start date. If you opt out an employee after day 56, you must 
specify the reason for the late opt out. The new Late Opt Out reason dropdown 
contains a list of possible reasons: 

• Did not meet the criteria to join KiwiSaver 
• Employer did not provide an investment statement 
• Employer did not provide information pack within 7 days of start date 
• Incorrectly enrolled employee under the age of 18 
• IR send an investment statement on allocation of default scheme 
• Opt-out application unable to be submitted within the time limit 
• Other explanation 

Other explanation  new Other 
reason field. 

The Include in next KED file option has been renamed to Include in next Employee 
Details file. As the Employee Details file replaces the KED file, ticking this option now 

 Employee Details file to 
be produced. 

Note:  
ticked automatically, but you can untick it if you do not want the employee 
included in the Employee Details file. 
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KiwiSaver Exempt Income 
This release adds the ability to report an income type for any transaction type that is 
exempt from KiwiSaver. This information is now reported for new employees in the 
Employee Details file as part of the payday filing updates. 

Note:  The Employee Details file does not include information about changes made 
to Allowances for existing employees. 

A new KiwiSaver exempt dropdown is available on the Configuration tab of the 
Transaction Type  Pay window: 

 
Use this dropdown to indicate the type of KiwiSaver-exempt income that the 
transaction type represents. Choose from: 

• Provide board-lodging, use of a house or part house or equivalent allowance 
• Some Honoraria payments 
•  
• Retiring allowance 
• Taxable allowances for accommodation and living costs overseas 
• Some payments under a Voluntary Bonding Scheme 

See  for 
more information. 

https://www.ird.govt.nz/kiwisaver/kiwisaver-employers/contributions-and-deductions/gross-pay-for-kiwisaver-and-complying-funds
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Desktop  Windows Designer Update 
The Windows Designer now supports customisation of the tables (also known as 
droplists) that show the results for search fields: 

 
In the new Droplist section, you can: 

• change the overall width of a results table and the number of rows it shows.  
• add, remove and re-order columns, except for the first column. 
• set  
• change what is shown in each column (except for the first column) by clicking 

the  control next to the property and selecting a different property from the 
window that appears. 

Properties can be the names of simple attributes of the underlying Jade class, e.g. the 
name of a customer, or can be more complex feature paths, e.g. the post code within 
an address. 

Note:  A Customisation is available on search fields shown directly on forms, not 
those embedded in tables. 
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Desktop  Query Panels 
You can now add queries as panels on a desktop. A new Query option is available in 
the Toolbox of the Desktop Designer to add a query to a desktop, drag this option 
onto the Layout, then select the required View and Query from the Properties section: 

 
If the Update in real time property is ticked, workflow panels that display a query are 
updated dynamically when records that match the query are added, modified or 
deleted. The Real time display delay property lets you specify a delay between when 
a record is updated and when the update is reflected on the panel. 

 

Integration with 3D Panels 
When an entry on a Query panel is selected, any 3D panels on the desktop are 
updated to use the selected entry. In the example below, the Highstone High (AUST) 
organisation is selected, causing all of the 3D panels on the right of the desktop to 
display data for that organisation. 
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Query Panel Parameters 
If the Allow parameter dialog property is ticked, then when the desktop is first loaded, 
a Parameters for Query window opens, allowing the user to enter any parameters set 
up in the source query: 

 

After the query has loaded, you can click the Refresh button (  ) to change the 
parameters and re-load the query. 

If Allow parameter dialog is not ticked, the query will load with the defaults specified 
for each parameter. To change the default parameters, double-click on the Parameters 
property to open the Parameters for Query window and enter new values. 

 
Right-clicking on the header of one of the columns in a query opens a menu with 
options related to parameters: 

• Display Parameters  displays the current parameter settings in a pop-up 
window. 

• Save Parameters  saves the current parameter settings as the default. 
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• Restore Default Parameters  if new default parameter settings have been 
saved with the Save Parameters option, selecting this option reverts the default 
settings to the defaults set up in the query. 

 
Note:  If the Allow parameter dialog parameter is not ticked, the Save Parameters 

and Restore Default Parameters options are not available in the right-click 
menu. 

Desktop  Default Sorting on Views 
You can now define a default sort order for views created with the Query Designer. 
On the new Sorting tab, you can add elements to sort the query by and set a sort 
order for each one. To make this easier, a new View Columns panel has been added 
to the toolbox on the right this panel contains all elements that have already been 
added on the Data View tab. 

 

  



 

MYOB Greentree 2021.1.0  Page 10 of 19 
Copyright 2021 MYOB Technology Pty Ltd. 

 

Desktop  Payment Selections Update 
This release adds new features to the Payment Selections window: 

• New Payment Terms From and To fields let you select payments based on a 
range of payment types. 

• A new Tree dropdown lets you select a tree to display in a new panel on the 
right. You can use the check boxes on the new tree panel set the branches to 
select payments from. 

 
These new features are also available on the Clear Selection window: 
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Security Improvements  
This release includes enhancements to system security. 

Note:  Recommended settings are detailed in the document MYOB Greentree 
Security Recommendations , which has been updated for this release. 

eModules  Password Updates 
Password changes for users of all modules are now subject to the same controls as for 
Greentree users on Windows client and Browser client. Those controls are the 
Advanced password management and Enforce password history settings on the 
Account Settings tab of the General System Preferences window. 

For Greentree users of eCRM, eRequisitions and eApprovals: 

• The maximum login attempts, password age and lockout duration are 
controlled by the settings on the General System Preferences window. 

• The Locked out of eModules check box on the CRM Preferences window has 
been replaced with Allow access to eCRM. 

• The existing Is account locked setting on the General tab of the User 
Preferences form is used to manage lockouts. 

For Contacts and Organisations using eService: 

• Password age is now controlled by settings on the General System Preferences 
window mentioned above. 

• As previously, lockouts have no time limit and the maximum number of login 
attempts is determined by the Max Login Attempts setting on the eModule 
Control window. 

For HR employees using eHR, as previously, lockouts have no time limit and the 
maximum number of login attempts is determined by the Max Login Attempts setting 
on the eHR Module Control window. 

For JC employees, eTimesheets lockouts, as previously, have no time limit and the 
maximum number of login attempts is determined by the Max Login Attempts setting 
on the eModule Control window. 

Points to note: 

• Messages for authentication failures have been generalised to The user name 
or password is invalid  to minimise disclosure of information. Messages for 

remain. 
• Failed login attempts by a Greentree user on Windows client, Browser client 

and eModules will no longer be counted separately. When the total exceeds 
the threshold, the user will not be able to log in any way, and this will be 
shown on the Is Account Locked setting on the General tab of the User 
Preferences form. 

• The upgrade process does not change user names or passwords, but it will lock 
the account of any Greentree user whose most recent eModules login attempt 
failed. 

• The changes comprise the 2021.1.0 package, which is applied by Packman, and 
minor updates to eModules ASP files, which need to be applied manually. 
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File Upload Updates 
This release tightens controls on uploading and saving file attachments. 

Filenames are now altered to contain only the characters A-Z, a-z, 0-9, space and 
underscore any other characters are replaced with an underscore. (The exception is 
a single period, which is allowed to provide the file extension). 

A new Restricted file extensions field has been added to Attachments sections of the 
following windows: 

• CRM System Options > Email/Attachments tab 
• CRM Module Control > Main tab 
• HR System Options > Email/Attachments tab 
• Workflow Module Control > Other tab 

 
This field contains a list of file extensions, separate by semicolons. Users will not be 
allowed to upload file attachments with extensions listed in this field. By default, the 
extensions exe, vbs, scr, com and bat are restricted, but you can edit this list to suit the 
needs of your organisation. 

  



 

MYOB Greentree 2021.1.0  Page 13 of 19 
Copyright 2021 MYOB Technology Pty Ltd. 

 

Support for OAuth 2 with Microsoft Exchange 
MYOB Greentree now supports OAuth 2 authentication with Microsoft Exchange. If 
OAuth 2 is enabled on your Microsoft Exchange server, users can authenticate 
themselves using an OAuth 2 login instead of the usual username/password 
authentication. 

On windows where users must enter email credentials, e.g. for CRM email filing or the 
eXchange EDI, the Credentials button opens an updated Email Credential 
Maintenance window, which now offers options for Basic or OAuth2 authentication: 

 
When OAUth2 is selected, the user enters their username and clicks Log in to be 
redirected to a Microsoft signin page, where they can log in with their OAuth 2 details. 
Once the user is successfully authenticated, the OAuth login token is stored in the 
Greentree system. You can use the Token Management window (System > Utilities > 

tokens are kept up to date, and set 
email reminders for when the tokens are due to expire. 

Note:  More information on using OAuth 2 is available in the document MYOB 
Greentree Security Recommendations , which has been updated for this 
release. 
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Desktop  Auto Print Report Option 
This release adds a new Auto print  option to the Output report to dropdown on the 
following reports: 

• Accounts Receivable 
o Invoices 
o Credit Notes 
o Receipts 
o Statements 

• Accounts Payable > Payment Selections 
o Print Remittances/Cheques 

• Purchase Orders 
o Purchase Order 

• HR > Payroll 
o Pay Slip 
o ETP Payment Summary (AUST Only) 
o Payment Summary (AUST Only) 

This option generates reports for customers or suppliers whose delivery method is 
Print, and skips those whose delivery method is Email. 

This option lets you generate print and email output separately using the same profile, 
for instance to re-run a report where there has been an error in printing but emails 
have been sent correctly. 

Desktop  User Interface Updates 
Updates to the Explorer Window 
The Explorer window has been updated to improve the layout of all controls 
(previously, some controls overlapped or were hidden by other elements of the 
window). 

This release also adds a Clear button to the Explorer window clicking this button 
returns the Explorer window to its original state. 

 
The Explorer window also now supports dynamic properties, which previously could 
only be seen in the Report Writer and Query Designer. 
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Window Menu 
The ability to float forms in the Greentree Windows client has been restored. This is 
useful if you want to show some forms inside the main Greentree form on one 
monitor and additional forms outside the main form in a second monitor. 

A popup menu built in to all MDI forms was removed by Jade in the 2018 upgrade 
included in the 2020.4.0 release. Equivalent functionality is now provided on the 
Window menu. The menu command Window > Float will float the active form. (The 
active form is the one whose caption ap it  
is also shown with a tick on the list of forms at the bottom of the Window menu). To 
return a floating form to its original place in the main form, ensure it is the active 
window then use menu command Window > Dock. 

 

Updates to HR Employee Balances 
The HR Employee Balances window now has Show balance in hours selected by 
default, so that it always shows meaningful data on opening, regardless of whether 
the employee calculates leave in weeks or days. 
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Active Only Option for HR Employee Maintenance 
A new Active Employees Only check box has been added to the HR Employee 
Maintenance window. When this box is ticked, the window will display only those 
employees whose Status  

 
The Active Employees Only check box is also available on the HR Employee 
Maintenance  Payroll and HR Employee Maintenance  Human Resources windows. 

eDocs  User Interface Updates 
PO Ref Link to Suppliers 
A PO Ref column is now available on the eDocs > Transactions tab of the Supplier 
Maintenance window. This column contains the value of the PO Ref field from the 
related eDoc AP Invoice: 
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Update to Supplier Line Mapping 
This release adds a Load Table button to the eDocs > Line Mapping tab on the 
Supplier Maintenance window. Where a supplier has a large number of mappings set 
up, this tab can take a long time to load. To avoid this, when there are more than 500 
mappings set up, the table is not loaded until the user clicks the Load Table button. 
Where there are less than 500 mappings, the table loads automatically as usual and 
the Load Table button is disabled. 

 

Deduct Withholding Tax on eDocs AP Invoices 
A Deduct withholding tax option is now available for eDocs AP Invoices. This option 
defaults to ticked if the supplier is a withholding tax supplier, but can be unticked for 
invoices that are expense reimbursements. When an AP Invoice is created, this setting 
is carried through to the AP Invoice. 

Note:  Sites will need to update the A&A rule used for importing eDoc AP Invoices. 
The new rule is available from the Greentree FTP site, and accommodates 
the addition of the new Deduct withholding tax field on the eDoc AP 
Invoice. If the rule i will cause the import to fail with the 
error 6070 Parameter number mismatch shown  in the eDoc Script Run log. 
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Resolved Issues  
Greentree Desktop 

 

• In some cases users were not able to login to a Test system after a registration 
pack was applied. 

• An error has occurred (1035) String too long
when creating or opening an AR Receipt. 

• The error message  could appear when 
importing a file for Australian BSBs in External Bank Maintenance. 

• The system could appear to freeze when selecting a Save to File task. This 
release adds a progress bar to the file-writing process that occurs on 
completion of a Save as File task. 

• Tables containing positive and negative numbers would not be sorted 
correctly. 

• When selecting Send Table Contents to Clipboard from a table, if the first cell in 
the first row was empty, data would be out of alignment in the exported file. 

• The Effective date field was mis-aligned on the GL Account Tree Assignment 
window. 

• Fields are now consistent in using commas as thousand separators, e.g. 
1,234,567.89 

• An issue preventing the correct display of the Taxable Payments Report 
Required field on the Country Maintenance form has been resolved. 

• A change has been made to the AP Outstanding Invoices report so that it no 
longer shows suppliers who have only outstanding invoices due after the 
selected date. 

• An issue has been resolved in maintenance of Customers and Suppliers for a 
country whose description exceeded 30 characters. 

• This release fixes issues where a database lock would be held while the system 
was waiting for a user response: 

o When loading a record in SO Packing Slip Maintenance, if the customer 

the user makes a selection. 
o When viewing a record assigned to an inactive us

user assigned to this record is currently inactive. It has been re-assigned 

user clicked OK. 
o When copying a sales order, if any of the lines were kitsets not held in 

stock, the user had to re-select components and the record would 
remain locked until they had done so. 

o The database would remain locked while running a SO Enquiry search. 
• When printing documents, the printed output did not come out of the printer in 

the sort order that was specified when the print task was submitted. 
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• This release corrects revaluation calculations for fixed assets. When an asset set 
up with a calculation based on useful life is revalued or adjusted, the 
revaluation/adjustment is now based on the remaining useful life, not the full 
useful life. 

• The BPM process now completes correctly when triggered from the API. 
• It was not possible to create PO Receipts and AP Invoices for Purchase Orders 

containing JC Lines for closed jobs (in AP or from eDocs). 
• On the Windows Designer, if multiple custom forms were created, when one of 

the forms was modified, the Default column on the Companies sub-tab would 
disappear. 

• ing lines 
in an AR Credit Note, if an A&A rule for AR Credit Notes was in place. 

• When a transaction analysis code was edited or removed from an AP Invoice, 
the transaction analysis was correctly updated so that it was unallocated, but 
on recall the AP Invoice did not show the deleted transaction analysis code. 

• Attempted access via null object reference
could occur when saving a Job Card report on a Sub Job created from a CRM 
Quote. 

• When an existing document was reopened or recalled and the Tax Type 
changed from I to E or E to I, the change was not saved. 

• The Data Import Manager did not output all lines into the .error file when a line 
failed. 

• Where the PO Line Item Expected Date is updated based on a change to the 
expected date on the header, this change is now retained when the order is 
reloaded. 

• For employees where Annual Leave is calculated in weeks, leave requests can 
now span multiple pay periods. 

• Users could be disconnected from Greentree and then be unable to log in 
again, if their connection was forced off or timed out. 

eDocs 
 eDocs: 

• A fix has been made so emails imported by eDocs tolerate Unicode characters 
in attachment names. 

• Documents created using the Merge eDocs function displayed the message 
 at the top of each page. 

• An error with the code 5028 could occur 
when approving eDocs from the Approvals screen. 
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